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Overview of the MTS Thesis 
The MTS program requires you to develop a thesis or project that reflects your academic 
specialization and vocational goals. The thesis represents research you design and carry out 
specifically for the MTS program, although it can draw on previous research you have done or 
on the research of others, provided appropriate acknowledgment is made. The thesis is guided 
and evaluated by a faculty member in the area of concentration. Depending on the nature of the 
project, a second faculty member (from the same discipline or a related area) also may serve as a 
reader and evaluator.  
 
• The topic for the thesis is approved by your faculty advisor in your field of specialization at 

the evaluation conference—generally held in the second semester of full-time registration or 
after you have completed 28 semester hours. You present a statement of your thesis plans, 
including the proposed topic, research and writing plan, research question, and bibliography.  

• The MTS Colloquium TS 601/602 (three semester hours of credit) and the MTS Thesis TS 
690 (six semester hours of credit) are courses designed to help you develop the thesis 
proposal and write the thesis. 

• If you expect to graduate in May, the finished copy of the thesis must be submitted to your 
faculty advisor by the date on the academic calendar. The thesis is graded either pass or fail.          

• To qualify for May graduation, the thesis must be approved by the advisor and posted to 
ProQuest (see next page), and the ”MTS Thesis Certification Form” (found on myGETS at 
https://mygets.garrett.edu/ICS/Student_Information/Student_Forms/) must be submitted to 
the registrar’s office by the date on the academic calendar.  

 
Thesis components 
The thesis should include a title page, a contents page, an introduction, the thesis chapters, and a 
bibliography or reference list. You also may include an acknowledgments page if you choose. 
This guide provides templates for the basic components; for items such as a list of abbreviations 
or a list of tables/figures, see the Turabian Guide, “Appendix: Paper Format and Submission.” 
The length of the thesis in its final double-spaced typed form is between 50 and 80 pages.  
 
Citation style 
You should consult with your advisor to determine which citation style is best suited to your 
thesis. For most master’s-level writing, Garrett-Evangelical follows Turabian style, taken from A 
Manual for Writers of Research Papers, Theses, and Dissertations, Ninth edition (or the Chicago 
Manual of Style, Seventeenth edition). Consult the following resources for this citation style: 
 
a.  Turabian, Kate L. A Manual for Writers of Research Papers, Theses, and Dissertations: 

Chicago Style for Students and Researchers. 9th ed. Chicago: The University of Chicago 
Press, 2018. 

 
b.  Staff, University of Chicago Press, ed. The Chicago Manual of Style. 17th ed. Chicago: The 

University of Chicago Press, 2017.  
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c.  Online resource: Turabian Citation Quick Guide, 
https://www.chicagomanualofstyle.org/turabian/turabian-notes-and-bibliography-citation-
quick-guide.html.  

 
d.  Online resource: Chicago-style Citation Quick Guide, 
 https://www.chicagomanualofstyle.org/tools_citationguide.html 
 
Students working in specific fields may use other citation styles as recommended by their 
advisors. For example, students in biblical studies may use The SBL Handbook of Style, Second 
edition (2014), and those working in pastoral care/pastoral psychology may use the Publication 
Manual of the American Psychological Association, Seventh edition (2020).  
  
a. Society of Biblical Literature. The SBL Handbook of Style: For Biblical Studies and Related 

Disciplines. 2nd ed. Atlanta: SBL Press, 2014.  
 

b. American Psychological Association. (2019). Publication Manual of the American 
Psychological Association. (7th ed.). American Psychological Association.  
 

Your advisor will recommend which guidelines to use based on the standards of their learned 
societies or their preferences for one of the systems above. All footnotes, endnotes, reference 
citations, and bibliographies or reference lists should conform to one of the above styles or 
another recommended by your faculty advisor.  
 
Formatting and layout  
The thesis should be formatted according to the following guidelines. The second section of this 
guide provides a template to use in formatting the thesis; you can copy the template pages of the 
guide and use them to begin formatting your thesis.   
 
Margins 
Leave a margin of one inch on all edges of the text. The one-inch margin also applies to 
headers/footers, footnotes, and images. 
 
Font and size 
Your thesis should be written in 12 pt. Times New Roman or another readable font such as Arial. 
 
Spacing and indentation 
The text should be double-spaced except for block quotations, footnotes, captions, bibliography 
entries, and long headings. Each of these should be single-spaced, but with a blank line added 
between items. Put only one space, not two, between sentences. Each new paragraph should be 
indented one-half inch using the tab function instead of spacing. To start a new page, insert page 
breaks instead of line spaces. To begin a new chapter, insert a section break.  
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Heads and subheads 
Format all chapter headings consistently. If there are subsections within a chapter, each one may 
have a title (a subhead); be sure to distinguish between different levels. If the chapter title is 
bold, upper-case, and centered, your first-level subhead could be upper-and-lower-case bold, left 
justified. The next level head could be upper-and-lower-case italic, left justified.  
 
Pagination 
No number should appear on the title page or the contents page. The rest of the text pages—
including introduction, thesis chapters, and bibliography or reference list—should be numbered 
with Arabic numerals, beginning with 1 and running consecutively until the end. Page numbers 
should be centered at the foot of the page, at least three-fourths of an inch from the bottom edge. 
 
For other questions on formatting, see Turabian, “Appendix: Paper Format and Submission.”  
 
Editing and proofreading 
If you need editing or proofreading assistance from the Writing Center, submit your thesis at 
least two weeks prior to the deadline for submission to the advisor. After reviewing the final 
draft, the advisor may recommend editing or proofreading prior to posting on ProQuest; if so, 
submit your thesis to the Writing Center at least two weeks prior to the final posting deadline.  
 
Final review  
Before submitting your thesis to your advisor—or to the Writing Center for editing and 
proofreading—be sure to do a final review and ask yourself the following questions:  
 
� Are grammar, spelling, and punctuation correct? 
� Are chapter titles and page numbers on the Contents page accurate? 
� Are key words/phrases or non-English words/phrases treated consistently? 
� Are citations included for every quote and paraphrase? 
� Are footnotes complete and following proper citation style? 
� Is the bibliography complete and following proper citation style? 
� Are authors’ names in the bibliography in alphabetical order? 
� Are heads and subheads formatted correctly and consistently? 
� Is spacing consistent (regular line spacing, block excerpts, bulleted/numbered lists)? 
� Are all components formatted consistently (regular text, block quotations, footnotes, etc.)? 
 
Submitting to ProQuest 
The seminary now requires the use of ProQuest to publish all MTS theses, DMin projects, and 
PhD dissertations. ProQuest makes the academic work available in a full-text format through 
online academic search engines, provides electronic copies to our library, and offers printing in 
book format as an optional service. After final approval from the advisor, students should post 
the thesis to ProQuest through a special web portal: http://www.etdadmin.com/cgi-
bin/school?siteId=217. Students are only required to submit the dissertation for Basic Publishing; 
students can choose additional copies and options. All fees for the service are collected by 
ProQuest at time of submission. This cost is subject to change at ProQuest’s discretion.  
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INTRODUCTION 

The page heading should appear on the first line, in upper-case bold to match entries on 

the contents page. Body text should be double-spaced except for block quotations, notes, 

captions, and long headings. Each of these should be single-spaced, but with a blank line 

between items. Here’s an example of a block quotation, single-spaced, with no quotation marks: 

Present a prose quotation of five or more lines as a block quotation. Introduce the 
quotation in your own words in the text. If you introduce the quotation with a complete 
sentence, end the sentence with a colon. If you use an attribution phrase such as notes, 
claims, argues, or according to along with the author’s name, end the phrase with a 
comma. If you weave the quotation into the syntax of your sentence, do not use any 
punctuation before the quotation if no punctuation would ordinarily appear there.1  
 

Chapter Subsections 

If there are subsections in a chapter, set off each with a separate subhead. If the chapter 

title is upper-case bold, centered, your first-level subhead could be upper-and-lower-case bold, 

left justified. The next level head could be upper-and-lower-case italic, left justified.  

Citing Your Sources  

Remember to cite your sources.2 Footnotes are single-spaced, but there should be one 

blank line between each. The first line of each footnote is indented one-half inch.3 

Page Numbering  

The first page of the introduction begins with Arabic number 1 and numbering continues 

to the end of the document. The title page and contents pages do not need numbers. The page 

number is centered at the foot of the page, at least three-quarters of an inch from bottom edge. 

 
1 Kate L. Turabian, A Manual for Writers of Research Papers, Theses, and Dissertations: Chicago Style for 

Students and Researchers, 9th ed. (Chicago: The University of Chicago Press, 2018), 361. 
 

2 Stephen J. Patterson, The God of Jesus: The Historical Jesus and the Search for Meaning (Harrisburg, 
PA: Trinity Press International, 1998), 156. 

 
3 Gerd Ludemann and Martina Janssen, Suppressed Prayers: Gnostic Spirituality in Early Christianity 

(Harrisburg, PA: Trinity Press International, 1998), 73. 
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CHAPTER ONE 
 

TITLE 
 

Chapter numbers and titles should start at the top of a new page. The first line of each 

new paragraph should be indented one-half inch using the tab function (not spacing) or by 

following these steps: 

1. Choose “Select All” from the Editing menu on the Home tab.  

2. Place your cursor on the Paragraph menu on the Home tab. 

3. Click on the arrow in the right corner of the Paragraph menu. 

4. Look under the “Special” drop-down menu in the Indentation section. 

5. Select “First Line.” 

6. This setting automatically indents the first line of a new paragraph.  

To start a new page, insert page breaks instead of line spaces. When beginning a new 

chapter, however, do not use page breaks!  Instead, use section breaks. This is important for 

numbering pages when you are finished writing. Page numbers should be the very last thing you 

do to your thesis, after all revisions, edits, and proofreading. To insert a section break, place your 

cursor at the end of the last line of text before the needed break, then:   

1. Click on the “Layout” tab in the menu at the top of the page. 
 

2. Click on the arrow next to “Breaks.” 
 

3. Under “Section Breaks,” click “Next Page.” 
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(Bibliography entries should be alphabetized by the author’s last name. Each entry should be 
single-spaced with the first line aligned at the left margin and all other lines indented  

one-half inch. Leave one blank line between each entry.) 
 

BIBLIOGRAPHY 
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Critical Methodology. Translated by P. Heinegg. Peabody, MA:  Hendrickson, 1996. 
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